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1   OSGeo Live 5.0

1.1   Requisiti minimi di sistema

• RAM: 1 GB, preferibilmente 2 GB.

• Spazio libero su hard disk: 10 GB

1.2   Installazione
Il presente workshop è svolto sulla distribuzione OSGeo Live 5.0 utilizzando la seguente configurazione:

• software di virtualizzazione VirtualBox;

• OSGeo Live 5.0 VM.

Istruzioni dettagliate per l'installazione di VirtualBox e del disco virtuale di OSGeo Live 5.0 sono presenti
in questa pagina (Autore: Alessandro Furieri a.furieri@lqt.it). Per ulteriori informazioni sulla distribuzione
consultare la pagina di OSGeo Live.

1.3   Configurazione di gvSIG su OSGeo Live
La distribuzione OSGeo Live 5.0 comprende una ricca raccolta di software GFOSS preinstallati e
preconfigurati, tra i quali gvSIG Desktop 1.11 (attuale versione stabile), alla quale si farà riferimento nel
seguito. In particolare, l'installazione di gvSIG presente in OSGeo Live 5.0 è configurata in modo tale da
aprire in avvio un progetto di esempio (descritto nel gvSIG Quickstart). Tuttavia, in tale progetto
l'estensione SEXTANTE non è utilizzabile, a meno che non si apra un nuovo progetto. Per evitare
l'apertura del progetto di esempio, si consiglia di eseguire il seguente script bash
(gvSIG_1_11_config.sh) incluso nella cartella dei dati:

#!/bin/bash
# declare variables
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gvSIG_sh=/opt/gvSIG_1.11/bin/gvSIG.sh
gvSIG_sh_clean=/opt/gvSIG_1.11/bin/gvSIG_clean.sh
cp $gvSIG_sh $gvSIG_sh_clean
# comment lines from 38 to 42
sed -i '38,42 s:^:#:' $gvSIG_sh_clean
# uncomment line 41
sed -i '41 s:#::' $gvSIG_sh_clean

# Desktop configuration file
echo "[Desktop Entry]" >> ~/Desktop/gvSIG-1.11.desktop
echo "Encoding=UTF-8" >> ~/Desktop/gvSIG-1.11.desktop
echo "Name=gvSIG-1.11" >> ~/Desktop/gvSIG-1.11.desktop
echo "Type=Application" >> ~/Desktop/gvSIG-1.11.desktop
echo "MimeType=application/x-gvsig;" >> ~/Desktop/gvSIG-1.11.desktop
echo "Exec=$gvSIG_sh_clean" >> ~/Desktop/gvSIG-1.11.desktop
echo "Icon=/opt/gvSIG_1.11/bin/ico-gvSIG.png" >> ~/Desktop/gvSIG-1.11.desktop
echo "Comment=gvSIG-Desktop-1.11" >> ~/Desktop/gvSIG-1.11.desktop
echo "Terminal=false" >> ~/Desktop/gvSIG-1.11.desktop
echo "StartupNotify=false" >> ~/Desktop/gvSIG-1.11.desktop
echo "Categories=Application;Education;Science;" >> ~/Desktop/gvSIG-1.11.desktop

Aprire una shell bash dal menù Applicazioni → Emulatore di terminale e recarsi nella directory dove lo
script bash gvSIG_1_11_config.sh è posizionato:

cd /home/user/Desktop/gvSIG_GFOSSDay2011/

e poi rendere il file eseguibile:

chmod +x gvSIG_1_11_config.sh

Adesso è possibile eseguire lo script bash:

./gvSIG_1_11_config.sh

Sarà creato un nuovo lanciatore di gvSIG 1.11 sul desktop che consentirà l'avvio di gvSIG a partire da un
nuovo progetto.

2   gvSIG Desktop

2.1   Breve introduzione
gvSIG Desktop è un programma orientato alla gestione dell'informazione geografica distribuito con
licenza GNU GPL v.2. E' caratterizzato da un'interfaccia semplice ed amichevole e dalla capacità di
accedere agevolmente ai formati raster e vettoriali più diffusi. Consente l'accesso a informazioni vettoriali
e raster, così come l'utilizzo di servizi web che soddisfano le specifiche dell'Open Geospatial Consortium
(OGC), quali WMS (Web Map Service), WFS (Web Feature Service), WCS (Web Coverage Service),
Servizi di Catalogo e Gazetteer.

L'applicazione è diretta ad utenti finali dell'informazione geografica, siano essi studenti, professionisti o
personale della pubblica amministrazione, di qualsiasi parte del mondo (attualmente l'interfaccia è
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disponibile in oltre venti lingue), aggiungendo alla potenza del programma il vantaggio di essere gratuito.

Vista la sua natura di software libero (free ed open source), risulta di grande interesse per la comunità
internazionale di sviluppatori e per le università grazie anche alle sue componenti di ricerca, sviluppo e
innovazione. Fin dal suo esordio, è stata presa in considerazione l'estensibilità del progetto, in modo che
gli sviluppatori potessero ampliare facilmente le funzionalità dell'applicazione e svilupparne di
completamente nuove a partire dalle librerie usate in gvSIG (sempre che soddisfino la licenza GPL).

2.2   Link di interesse

• Portale della comunità di gvSIG

• Documentazione per gli utenti

• Lista di discussione internazionale

• Lista di discussione italiana

• Manuale gvSIG v.1.1 (in italiano)

• Manuale gvSIG v.1.9 Nuove funzionalità (in italiano)

• Manuale gvSIG v.1.11 (in inglese)

• gvSIG Desktop su OSOR.eu

• gvSIG Mobile su OSOR.eu

• Associazione gvSIG

• gvSIG Training

• gvSIG Outreach

• gvSIG Blog

• gvSIG Planet

• Scheda informativa di gvSIG su OSGeo.org

• Stato di incubazione di gvSIG su OSGeo.org

2.3   Avvertenze

• Nel seguito, si considera che i dati utilizzati nel presente workshop siano collocati nella cartella
/home/user/Desktop/gvSIG_GFOSSDay2011/dati/.

• La maggior parte delle funzionalità di gvSIG è utilizzabile sia da opzioni di menù, che dalle barre
degli strumenti. Nel seguito, per brevità, si farà riferimento e si citeranno quasi esclusivamente le
opzioni di menù, generalmente meno visibili rispetto ai pulsanti degli strumenti.

3   Configurazione delle preferenze
Dal menù Finestra → Preferenze:

• Generale → Lingua: per cambiare la lingua dell'applicazione, installarne una nuova o un
aggiornamento, o esportare in un file la traduzione di una lingua.

• Generale → Cartelle: per definire i percorsi delle cartelle (progetti, dati, tavole e simboli)
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• Vista: per cambiare il sistema di riferimento spaziale (SRS) predefinito delle viste, il fattore di zoom,
il colore di selezione, le unità di mappa...

• Vista → Ordine di caricamento dei layer: per cambiare l'ordine di caricamento dei layer raster e
vettoriali

• Codifica predefinita dei DBF: per configurare la codifica predefinita delle tabelle in formato DBF.

• Simbologia: per configurare i colori predefiniti, la cartella dei simboli e il carattere predefinito...

• Editazione: per configurare i colori in fase di editazione grafica

• Mappa: per attivare/visualizzare la griglia e il righello in una mappa

• Supporto cartografico: per cambiare l'unità di misura predefinita

• Rete → Firewall / Proxy: per configurare eventualmente un proxy

• ...

Preferenze in avvio

• Al primo avvio di gvSIG su OSGeo Live 5.0, l'interfaccia dell'applicazione è in lingua inglese.
Per configurare l'applicazione in italiano, cliccare sul menù Window → Preferences, recarsi
poi in General → Language e attivare la lingua italiana. Cliccare su Accept e riavviare gvSIG.

• (consigliato) Nel workshop si utilizza EPSG:32633 (WGS84 / UTM 33N) come sistema
predefinito delle viste. A tal fine, nelle preferenze della vista cliccare sul pulsante relativo alla
proiezione predefinita e nella finestra Nuovo CRS selezionare:

• Tipo: EPSG,

• Criterio di ricerca: Per codice,

• Digitare 32633 nella casella di testo,

• Cliccare su Cerca e poi su Accetta.

• (consigliato) Nelle preferenze delle cartelle, impostare il percorso della cartella contenente i
dati geografici come /home/user/Desktop/gvSIG_GFOSSDay2011/dati e quello della
cartella contenente i progetti come /home/user/Desktop/gvSIG_GFOSSDay2011.

• (consigliato) Nelle preferenze della simbologia, attivare la casella di controllo Casuale nel
Colore di riempimento predefinito.
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4   Struttura e configurazione di un progetto in gvSIG
I file di progetto di gvSIG sono dei file XML con estensione .gvp che memorizzano al loro interno il
percorso delle sorgenti di dati geografici utilizzate. Ogni progetto può contenere tre diverse tipologie di
documenti:

• Viste: dove si lavora con la componente grafica dei dati.

• Tabelle: dove si lavora con la componente alfanumerica dei dati.

• Mappe: dove è possibile assemblare le carte geografiche (mappe) mediante l'inserimento dei diversi
elementi cartografici che le compongono (vista, legenda, scala, ...) per essere stampate o esportate
in un file pdf.
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Una volta aperto gvSIG, appare immediatamente il Gestore di progetto, mediante il quale è possibile
definire viste, tabelle e mappe.

5   Creare una vista e aggiungere uno shapefile

• Aggiungere una nuova Vista: dal Gestore di progetto, cliccare su Nuovo, selezionare la nuova
vista e cliccare su Proprietà.

• Nella finestra Proprietà della vista, cambiare il nome in Italia e impostare la proiezione attuale
come EPSG:23032 (ED50/UTM 32N) selezionando:

• Tipo: EPSG,

• Criterio di ricerca: Per codice,
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• Digitare 23032 nella casella di testo,

• Cliccare su Cerca e poi su Accetta.

• Aprire la nuova vista: nel Gestore di progetto, selezionare la nuova vista e cliccare su Apri.

• Una Vista è composta da tre diversi elementi:

1. Vista geografica: dove sono caricati i layer e si gestisce la parte grafica dell'informazione
geografica.

2. Tabella dei Contenuti (TOC): contiene il riferimento dei layer caricati nella vista. L'ordine di
visualizzazione dei layer nella TOC corrisponde a quello della vista geografica.

3. Localizzatore: consente l'orientamento e la navigazione veloce rispetto alla vista geografica.

• Dal menù Vista → Aggiungi layer aprire il file reg2011_g.shp presente nella cartella dei dati.
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• Salvare il progetto come GFOSS DAY 2011 dal menù File → Salva progetto.

• Chiudere gvSIG.

• Aprire gvSIG e dal menù File → Apri progetto aprire il progetto appena salvato.

6   Navigazione nella vista

6.1   Strumenti di base

• Sposta, Aumenta zoom, Riduci zoom, Zoom completo...

• Localizzatore:

• Vista → Configura localizzatore

• Aggiungi layer reg2011_g.shp

Suggerimento

Per cambiare la simbologia di un layer vettoriale aggiunto nel Localizzatore, cliccare sul pulsante
Modifica legenda e poi chiudere la finestra di dialogo del Localizzatore.
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• Zoom al layer:

• Aggiungere il layer LS7-RGB-Foggia-23032.tif nella vista. Selezionarlo nella TOC,
cliccarvi sopra con il tasto destro del mouse e scegliere poi l'opzione Zoom al layer dal menù
contestuale.
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• Gestore zoom (1):

• Aggiungere il layer prov2011_g.shp e rendere gli altri due non visibili.

• Realizzare uno zoom sulla regione Puglia.

• Vista → Navigazione → Gestore zoom e salvare lo zoom corrente come Puglia.
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• Centra la vista su un punto:

• Vista → Centra la vista su un punto utilizzando le seguenti coordinate:

• X: 1047000

• Y: 4611000
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• Gestore zoom (2):

• Vista → Navigazione → Gestore Zoom, selezionare lo zoom precedentemente salvato e
cliccare su Seleziona.

6.2   Aree e distanze

• E' possibile misurare aree e distanze all'interno di una vista (da Vista → Consultazione → Misura...).

6.3   Localizza per attributo

• Un altro strumento di navigazione nella vista è Localizza per attributo, mediante il quale è possibile 
realizzare uno zoom su un particolare elemento di un layer, selezionando un campo del layer ed un
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particolare valore assunto dallo stesso campo.

• Vista → Localizza per attributo con i seguenti valori:

• Layer: prov2011_g.shp

• Campo: NOME_PRO

• Valore: BARI

6.4   Scala della vista

• La scala di una vista può essere modificata dalla barra della scala. E' possibile selezionare valori di
scala predefiniti o definirne di personalizzati.

7   Simbologia

7.1   Legende e simbologia di base
È possibile modificare un simbolo cliccando due volte sull'anteprima del simbolo nella TOC.

• Proprietà del layer: doppio clic sul layer prov2011_g.shp nella TOC.

• Selezionare la scheda Simbologia, quindi Categorie → Valori unici; Campo di classificazione:
NOME_PRO; cliccare su Aggiungi tutti e poi su Accetta.

• Modificare la simbologia di un poligono:
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• Accedere alle Proprietà del layer, cliccare due volte sul simbolo relativo alla provincia di Foggia.

• Cliccare su Seleziona simbolo e cambiare il colore del riempimento e del bordo.

Esercizi

• Applicare una legenda Categorie → Espressioni tale da mostrare solo le regioni italiane con
SUP_KMQ > 10000.

• Personalizzare le proprietà della simbologia sperimentando le varie opzioni di simbologia dei
poligoni, utilizzando una campitura e modificando il colore del bordo.

7.2   Legenda per intervalli

• Fare una copia del layer precedente: tasto destro del mouse sul layer nella TOC, selezionare Copia
e poi Incolla.

• Proprietà → Simbologia del layer prov2011_g.shp.

• Selezionare Quantità → Intervalli e i seguenti valori:

• Campo di classificazione: SUP_KMQ

• Tipo di intervalli: Intervalli uguali

• Colore iniziale: blu

• Colore iniziale: rosso

• Numero di intervalli: 8

• Calcolare gli intervalli di simbologia e quindi accettare.
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Nota

E' presente un bug per cui le etichette Colore iniziale e Colore finale nella Scala dei colori risultano
invertite tra loro.

7.3   Etichettatura

• Accedere alle proprietà del layer prov2011_g.shp e quindi alla scheda Etichettatura
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• Selezionare Abilita etichettatura e impostare i seguenti valori:

• Impostazione generale: Attributi dell'etichetta definiti in tabella

• Campo da etichettare: NOME_PRO

• Altezza fissa: 10

• Unità: pixel, nel mondo

• Colore fisso: nero

7.4   Legenda predefinita
gvSIG ha un proprio formato di file legenda con estensione .gvl, nel quale sono memorizzate le
impostazioni della simbologia.

• Creare una nuova vista chiamata Provincia di Foggia definita in EPSG:32633.

• Aggiungere nella vista i layer prov_Foggia_32633.shp, foggia_highway_32633.shp e
LS7-RGB-Foggia-32633.tif (tutti definiti in EPSG:32633).

• Aggiungere il layer prov_Foggia_32633.shp anche nel localizzatore.

• Rendere visibili solo i layer prov_Foggia_32633.shp e foggia_highway_32633.shp.

• Impostare il colore di riempimento del layer prov_Foggia_32633.shp come (R,G,B) =
(241,238,232).

• Accedere alle proprietà del layer foggia_highway_32633.shp e poi alla scheda Simbologia.

• Cliccare sul pulsante Recupera legenda... e aprire il file strade_osm.gvl.

Workshop di gvSIG GFOSS Day 2011, Foggia 24-25 novembre 2011

Autore: Antonio Falciano, afalciano@yahoo.it - Licenza: Creative Commons BY-NC-SA Pag. 20

mailto:afalciano@yahoo.it


• Una legenda può anche essere esportata nel formato di interscambio di simbologia Styled Layer
Descriptor (.sld) in modo da poterla condividere con altre applicazioni, tuttavia gvSIG non supporta
completamente tale formato, pertanto alcune proprietà potrebbero andare perse.

• Accedere a Proprietà → Simbologia del layer foggia_highway_32633.shp.

• Cliccare su Salva legenda e salvarla come file .sld.

7.5   Trasparenza di un layer raster

• Cliccare con il tasto destro sul layer LS7-RGB-Foggia-32633.tif e poi Proprietà del raster.

• Selezionare la scheda Trasparenza.

• Attivare l'Opacità e impostare il 35% di trasparenza.
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Esercizi

• Utilizzare i controlli delle bande per modificare l'assegnazione dei colori.

• Rimuovere il colore nero dal layer raster attivando la trasparenza per pixel.

8   Strumenti dei layer

8.1   Riproiezione layer vettoriali

• Aggiungere il nuovo layer comuni_foggia_23032.shp (utilizzando la proiezione attuale
EPSG:32633).

• Effettuando uno Zoom al layer si osserva che le coordinate del nuovo layer non sono corrette.

• Eliminare pertanto il layer appena caricato e aggiungerlo nuovamente alla vista avendo cura di
impostare come proiezione:

• Tipo: EPSG

• Criterio di ricerca: Per codice

• Codice: 23032 (cliccare su Cerca)

• Selezionare Trasformazione EPSG e cliccare su Successivo.

• Trasformazione: 1133 ED50 to WGS84 (1) (Austria, Belgium, ..., Italy,
...) e cliccare su Finalizza.

• Finalizzare la riproiezione e accettare l'avviso successivo.
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8.2   Aggiungi layer di eventi
Un layer di punti può essere aggiunto in una vista a partire da una tabella alfanumerica contenente le
coordinate.

In primo luogo, la tabella deve essere aggiunta al progetto:

• Dal Gestore di progetto, selezionare il documento Tabella, quindi Nuovo e infine Aggiungi.

• Selezionare il file toponimi_foggia.dbf.
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• Infine, dal menù Vista → Aggiungi layer di eventi selezionare i seguenti valori:

• Tabella: toponimi_foggia.dbf

• X: X_32633

• Y: Y_32633

• Cliccare infine su OK.

Nota bene

Un layer di eventi in gvSIG è solo una rappresentazione grafica di una tabella alfanumerica.
Pertanto, nessun dato è stato realmente convertito da questo processo.

8.3   Aggiungi informazioni geometriche

• Rendere visibile il layer foggia_highway_32633.shp nella vista.

• Cliccare sull'opzione di menù Layer → Aggiungi informazioni geometriche.

• Nella finestra Aggiungi informazioni geometriche, selezionare il layer
foggia_highway_32633.shp e Lunghezza come informazione geometrica.

• Cliccare sul pulsante Aggiungi selezione e poi su Accetta.
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Nota bene

Lo strumento Aggiungi informazioni geometriche è in grado di calcolare ed aggiungere nella
tabella degli attributi i seguenti campi:

• le coordinate (X, Y e Z) nel caso di layer di punti;

• la Lunghezza nel caso di layer di linee;

• l'Area e il Perimetro nel caso di layer di poligoni.

9   Esportazione dei dati

9.1   Esportazione della vista come immagine
Una Vista può essere esportata come file di immagine senza georeferenziazione. Questa funzionalità è
utile quando vogliamo aggiungere la Vista a documenti, presentazioni, ecc.

• Per salvare la vista corrente utilizzare il menù Vista → Esporta → Immagine.
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9.2   Esportazione di un layer
E' possibile realizzare l'esportazione di un layer vettoriale in altri formati (SHP, DXF, PostGIS, ...).
Essendo un layer di eventi solo un layer virtuale, per poter ottenere un layer a tutti gli effetti occorre
esportarlo, ad esempio, in formato shapefile.

• Rendere attivo il layer di eventi toponimi_foggia.dbf. Se ci sono elementi selezionati in questo
layer, solo questi elementi saranno esportati, altrimenti tutti gli elementi del layer saranno esportati
nel nuovo layer.

• Cliccare sull'opzione di menù Layer → Esporta come... → SHP e salvare come
toponimi_foggia_32633.shp nella cartella dei risultati.

• Analogamente, esportare come SHP il layer comuni_foggia_23032.shp chiamandolo
comuni_foggia_32633.shp.

Nota bene

Un layer riproiettato viene esportato utilizzando lo stesso sistema di riferimento (CRS) della vista.

10   Strumenti di selezione

10.1   Strumenti di base

• Creare una nuova vista in EPSG:32633 e rinominarla come Foggia2.

• Aggiungere i layer comuni_foggia_32633.shp e toponimi_foggia_32633.shp (ottenuti in
precedenza).
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• In gvSIG, è possibile usare i seguenti strumenti base di selezione (dal menù Vista → Selezione):

• Selezione con punto

• Selezione con rettangolo

• Selezione con poligono

• Selezione con polilinea

• Selezione con cerchio

• Utilizzare il tasto "Ctrl" per le selezioni multiple.

10.2   Selezione con area di influenza
Altro tipo di selezione è la Selezione con area di influenza. Per usare questo strumento, occorre avere un
layer attivo.

• Rimuovere qualsiasi selezione precedente con lo strumento Annulla selezione (dalla barra degli
strumenti).

• Attivare il layer comuni_foggia_32632.shp e selezionare il comune di Foggia mediante lo
strumento Selezione con punto.

• Cliccare su Vista → Selezione → Seleziona con area di influenza.

• Inserire 15,00 km come larghezza dell'area di influenza (buffer).

• Nelle Opzioni, attivare Aggiungi layer d'area di influenza. Cliccare su Accetta.

• Sarà effettuata la selezione dei comuni in un intorno di 15 km rispetto al comune di Foggia, sarà
aggiunto un nuovo layer vettoriale con il buffer calcolato e si aprirà una finestra di dialogo con i
dettagli del processo.
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10.3   Selezione per attributi (Filtro)
Invece di usare strumenti grafici, è anche possibile realizzare una selezione basata sui valori della tabella
degli attributi.

• Rimuovere qualsiasi selezione precedente con lo strumento Annulla selezione.

• Aggiungere il layer foggia_highway_32633.shp nella vista e attivarlo nella TOC.

• Cliccare sull'opzione di menù Tabella → Filtro.

• Eseguire la query TYPE = 'motorway' e cliccare su Nuovo.
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Nota bene

È possibile concatenare diverse selezioni aggiungendo o sottraendo elementi dal gruppo di
selezione corrente.

10.4   Selezione spaziale
E' possibile eseguire una selezione più complessa sulla base di regole spaziali topologiche. In questo
esempio, si selezionano tutti i comuni attraversati dalle strade selezionate in precedenza.

• Attivare il layer comuni_foggia_32633.shp.

• Cliccare sull'opzione di menù Vista → Selezione → Selezione per layer

• Eseguire la seguente query:

Seleziona dai layer attivi gli elementi che...
intersecano
...gli elementi selezionati del layer
foggia_highway_32633.shp

• Cliccare su Nuovo insieme.
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Nota bene

È possibile concatenare diverse selezioni aggiungendo o sottraendo funzioni dal gruppo di
selezione corrente.

11   Tabelle degli attributi
gvSIG presenta diverse funzionalità che consentono all'utente di esplorare e gestire la tabella degli
attributi associata ai layer vettoriali.

• Attivare il layer comuni_foggia_32633.shp (dovrebbe contenere già diversi elementi selezionati
nell'esercizio precedente).

• Aprire la tabella degli attributi: Layer → Mostra tabella degli attributi.

• Spostare gli elementi selezionati in alto: Tabella → Sposta selezione in alto

• Selezionare gli elementi complementari alla selezione attuale: Vista → Inverti selezione.

• Effettuare uno Zoom alla selezione.
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11.1   Strumenti di consultazione
Le informazioni degli elementi possono essere consultate con due strumenti diversi: Informazioni e
Informazioni rapide.

• Attivare il layer comuni_foggia_32633.shp.

• Con lo strumento Informazioni (Vista → Consultazione → Informazioni) cliccare su un elemento del
layer comuni_foggia_32633.shp.

• Cliccare su Vista → Consultazione → Informazioni rapide.

• Selezionare il layer comuni_foggia_32633.shp, attivare il campo NOME_COM e selezionare il
campo dell'area. Dopo aver accettato, quando il mouse si troverà su un elemento del layer, saranno
mostrate direttamente le sue informazioni.
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11.2   Strumenti delle tabelle

11.2.1   Sommario di una tabella
Questo strumento crea una nuova tabella contenente i valori unici di un campo di raggruppamento e le
statistiche dei valori numerici degli altri attributi.

• Attivare il layer foggia_highway_32633.shp e aprirne la tabella degli attributi.

• Aprire lo strumento Sommario tabella (dalla barra degli strumenti).

• Scegliere TYPE come campo di raggruppamento.

• Quindi selezionare le statistiche minimo, massimo e somma del campo della lunghezza.

• Salvare come nuovo file dbf nella cartella dei risultati come sommario_strade.dbf.

• Questa tabella viene aggiunta al progetto di gvSIG.

11.2.2   Unione di tabelle
Si intende unire il file pop2010_foggia.csv nel formato Comma Separated Value (CSV), contenente i
dati ISTAT sulla popolazione al 1° gennaio 2011, con il layer comuni_foggia_32633.shp.

• Aprire il Gestore di progetto, cliccare su Tabella, Nuovo e poi Aggiungi.

• Aggiungere pop2010_foggia.csv scegliendo csv string come Tipo file.

• Aprire la tabella degli attributi del layer comuni_foggia_32633.shp.

• Cliccare su Tabella → Unione.

• Selezionare comuni_foggia_32633.shp, campo PRO_COM, prefisso com e cliccare su
Successivo.

• Poi pop2010_foggia.csv, campo CODICE, prefisso pop e cliccare su Fine.
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• Si otterrà una tabella unione con i prefissi indicati che identificano la tabella di provenienza dei
singoli campi.
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Nota bene

• Per una corretta importazione dei file CSV in gvSIG è preferibile usare il punto e virgola (;)
come separatore di campi e il punto (.) come separatore decimale.

• I campi derivanti dall'importazione di un file CSV in gvSIG sono considerati tutti di tipo String.

• La tabella derivante dall'unione è solo virtuale e quindi i dati di partenza non sono modificati.

• È possibile rimuovere l'unione di due tabelle da Tabella → Elimina unione.

11.2.3   Importa campi
L'importazione di campi è un'operazione simile all'unione di tabelle, tuttavia i campi importati sono
realmente memorizzati nella tabella. La prima operazione consiste nel copiare il file shape in cui si
desidera importare uno o più campi.

• Rimuovere l'unione delle due tabelle realizzata in precedenza mediante la voce di menù Tabella →
Elimina unione.

• Esportare il layer comuni_foggia_32633.shp come SHP, rinominarlo come
comuni_foggia_pop2010.shp e aprirne la tabella degli attributi.

• Cliccare sull'opzione di menù Tabella → Importa campi

• Selezionare i seguenti valori:

• Tabella: comuni_foggia_pop2010.shp

• Campo di collegamento: PRO_COM

• Tabella da importare: pop2010_foggia.csv

• Campo di collegamento: CODICE
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• Cliccare quindi su Avanti.

• Selezionare i campi MASCHI, FEMMINE e TOTALE, utilizzando rispettivamente gli alias M_2010,
F_2010 e TOT_2010 e cliccare quindi su Fine.

11.2.4   Esportazione di una tabella
Questa funzione consente di esportare qualsiasi tabella in formato dBase (.dbf) o in formato Microsoft
Excel (.xls).

11.3   Codifica delle tabelle

• Aggiungere la tabella reg2011_g.dbf. Si noteranno alcuni caratteri strani in alcune celle della sua
tabella degli attributi. Questo perchè la codifica dei caratteri non è ben impostata.

• Chiudere gvSIG.

• Ripetere la copia del layer reg2011_g.shp nella cartella dei dati.

• Aprire nuovamente gvSIG e aggiungere la tabella reg2011_g.dbf: si vedranno dei caratteri strani
nel campo NOME

• Assegnare la codifica ISO-8859-1 dal menù Tabella → Assegna codifica a file .dbf.

• Eliminare la tabella dal progetto gvSIG.

• Creare una nuova vista e aggiungere nuovamente il layer reg2011_g.shp. Applicando un sistema
di etichettatura basato sul campo NOME_REG i caratteri corretti con accenti, apostrofi, ecc. saranno
visualizzati correttamente.

Prima

Dopo
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12   Visualizzazione e interrogazione di dati remoti

12.1   Impostazioni proxy
Prima di tutto, se è utilizzato un proxy nella navigazione sul web, occorre modificare le impostazioni di
gvSIG da Finestra → Preferenze → Rete → Firewall/Proxy e impostarne i suoi parametri.

12.2   Web Map Service (WMS)
All'interno di una vista di gvSIG possiamo utilizzare sia dati locali che remoti (WMS, WFS, WCS, ...).

• Copiare la vista Provincia di Foggia già esistente (nel Gestore di progetto). Si intende
aggiungere un layer WMS in questa vista.

• Cliccare su Vista → Aggiungi layer e recarsi nella scheda WMS. Inserire l'URL:
http://iws.sit.puglia.it/ecwp/ecw_wms.dll? e cliccare su Connetti. Se la connessione
va a buon fine, dovrebbe apparire la descrizione del servizio (se presente).

• Cliccare sul pulsante Successivo. Nella scheda Layer selezionare il layer Puglia_2006, quindi
cliccare sul pulsante Aggiungi. Selezionare il formato image/png e come SRS del layer
EPSG:32633. Il layer sarà aggiunto nella TOC della vista.

12.3   Web Map Context (WMC)

12.3.1   Esportazione come WMC
Se all'interno di una vista è stato aggiunto almeno un layer WMS, è possibile esportare un file WMC
(estensione .cml) che consente di salvarne le impostazioni locali (layer, zoom, estensione).

• Si dovrebbe avere almeno un layer WMS nella TOC (in caso contrario, aggiungerne uno alla vista),
fare clic sullo strumento Centra la vista su un punto e digitare le coordinate X = 597540 e Y =
4637300 (Vieste). Una volta che la vista è stata centrata su queste coordinate contrassegnate da un
simbolo rosso, cambiare la scala sulla barra di stato in 1:25000.

• Il passo successivo consiste nel salvare lo stato della vista come file WMC. Per effettuare tale
operazione, cliccare su Vista → Esporta → Web Map Context. Nella finestra Proprietà Web Map
Context, selezionare una vista e definire il titolo, un identificativo e il nome del file. E' importante
salvare il file .cml in una cartella in cui si dispone dei permessi di scrittura. Infine, come Estensione
scegliere l'opzione Utilizza estensione della vista.

12.3.2   Importazione di file WMC
Al contrario, è possibile importare un file WMC all'interno di una vista in modo da ripristinare le stesse
impostazioni dei layer WMS salvate precedentemente.

• Creare una nuova vista e cliccare sull'opzione di menù File → Importa → Web Map Context al fine di
selezionare e caricare il file WMC salvato in precedenza. La nuova vista dovrebbe avere lo/gli
stesso/i layer WMS (e proprietà) e la stessa estensione di quella originale. La stessa operazione
potrebbe essere realizzata importando il file WMC in un altro computer.
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12.4   Web Feature Service (WFS)
Il servizio WFS permette di lavorare con layer vettoriali caricati da un servizio remoto. I dati sono scaricati
in formato GML (Geography Markup Language).

• Creare una nuova vista, dove il layer WFS sarà aggiunto. Collegarsi a
http://localhost:8082/geoserver/wfs e selezionare il layer USA Population.
Selezionare tutti gli attributi nella scheda Campo. Nella scheda Opzioni non cambiare il valore del
numero max di elementi (1000 di default). Infine, mantenere le impostazioni predefinite per le opzioni
delle schede Filtro e Area.

• Dopo la procedura guidata, un layer vettoriale sarà aggiunta alla TOC della vista. Questo layer si
comporterà come un qualsiasi altro layer vettoriale e, ad esempio, sarà possibile cambiare la sua
simbologia. Nel menù contestuale del layer, cliccare su Proprietà e selezionare la scheda
Simbologia. Scegliere l'opzione Valori unici e impostare la legenda in base al campo ....

• Applicare la nuova legenda ed esportare il layer come shapefile (Layer → Esporta → SHP). In
alternativa, è possibile esportare il layer WFS in altri formati come DXF, KML, GML e PostGIS.

• Infine, cercare di modificare i parametri di richiesta dal menù contestuale in Proprietà del layer WFS.
Ad esempio, utilizzare l'opzione Filtro, cambiare la richiesta di campi o il numero massimo di
elementi da caricare.

12.5   Web Coverage Service (WCS)
Mediante questa tipologia di servizio web, è possibile caricare delle coperture (coverage) nella vista di
gvSIG, ovvero layer raster, come ad esempio un DTM, che a differenza dei layer WMS sono interrogabili.

• Creare e aprire una nuova vista dal Gestore di progetto di gvSIG. Selezionare Aggiungi layer, quindi
recarsi nella scheda WCS. Collegarsi all'URL http://localhost:8082/mapserver/wcs.

• Una volta connessi, selezionare il layer DTM 90m e nella scheda Formato selezionare GEOTIFF.

• Nell'ultima scheda, è possibile selezionare le bande dell'immagine da caricare. Selezionare l'unica
disponibile. Dopo aver accettato, il layer sarà aggiunto alla vista.

• Dal menù contestuale, è possibile modificare le Proprietà del layer WCS, analogamente agli altri
servizi web appena descritti.

12.6   Accesso a geodatabase PostGIS
gvSIG è in grado di accedere alle tabelle di PostgreSQL, così come i layer di PostGIS contenenti
informazioni geografiche. Al fine di caricare un layer PostGIS, è necessario attenersi alla seguente
procedura:

• All'interno di una vista, cliccare su Vista → Aggiungi layer → Geodatabase e cliccare sul pulsante
Aggiungi connessione sulla destra.

• Nella finestra Parametri di connessione, inserire i seguenti parametri:

• Nome connessione: test PostGIS

• Driver: PostGIS driver JDBC

• URL del server: localhost

• Port: 5432
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• Nome del database: postgres

• Utente: postgres

• Password: xxxxxxxx

• Attivare la casella di controllo Connesso.

• Fare clic sul pulsante Accetta e si vedrà l'elenco dei layer disponibili. Selezionare il layer
public.xxxxxxx e tutti i campi di tale layer appariranno sulla colonna di destra. È possibile
selezionare uno o più campi. Selezionare i campi gid (campo identificativo delle geometrie) e
the_geom (campo delle geometrie).

• E' possibile, inoltre, impostare una restrizione SQL oppure limitare l'estensione spaziale dell'area di
interesse.

• Dopo aver accettato nella finestra di accesso a PostGIS, il layer è aggiunto alla vista come un
qualunque altro layer vettoriale. Questo significa che si è in grado, ad esempio, di cambiare la sua
simbologia ed aprire la sua tabella degli attributi.

12.7   Ricerca di toponimi (Gazetteer)
I servizi di Gazetteer (WFS-G) consentono di collegare i toponimi con le rispettive coordinate
geografiche. gvSIG è dotato di un client di ricerca di toponimi mediante il quale è possibile effettuare la
ricerca per parole chiavi geografiche e mostrare i toponimi risultanti all'interno di una vista di gvSIG.

• Cliccare sull'icona Cerca per toponimi. Comparirà la sua finestra dei parametri (ricordarsi che tale
icona non viene visualizzata fino a quando non si carica almeno un layer nella vista).

• Connettersi al server http://www.geonames.org:80 selezionando il protocollo Geonames.

• Digitare la parola chiave Foggia e cliccare su Cerca. Selezionare uno dei risultati che saranno
visualizzati nel seguito e cliccare poi su Localizza.

• Successivamente, comparirà un punto rosso nella vista centrato in quel luogo, che mostrerà la
posizione e il nome del toponimo.

• Una volta comparso tale punto sulla vista, sulla barra degli strumenti appare una nuova icona
raffigurante una gomma (Elimina le ricerche precedenti) per cancellare i toponimi aggiunti in
precedenza.

13   Editazione grafica e alfanumerica

13.1   Creazione di un nuovo layer vettoriale
In questa esercitazione si intende di creare un nuovo layer vettoriale a partire da zero in una nuova vista.

• Creare una nuova vista definita nel sistema EPSG:32633 e chiamarla Editazione.

• Connettersi al servizio WMS http://iws.sit.puglia.it/ecwp/ecw_wms.dll? e caricare il
layer Puglia_2006, utilizzando le stesse impostazioni utilizzate in precedenza (formato
image/png e stesso SRS della vista).

• Utilizzare la strumento Centra la vista su un punto con le coordinate (X = 545115, Y = 4590258)
della Facoltà di Lettere e Filosofia dell'Università degli Studi di Foggia. Quindi impostare la scala
della vista pari a 1:2000.
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• Cliccare sull'opzione di menù Vista → Nuovo layer → Nuovo SHP per creare un nuovo layer
vettoriale.

• Inserire il nome del layer (edifici), selezionare l'opzione Tipo poligono e fare clic su Avanti.

• Aggiungere un nuovo campo denominato dest_uso di tipo String e lunghezza predefinita.

• Nella finestra successiva, selezionare il nome e il percorso dove salvare il layer su disco.

Nota bene

Fare attenzione a salvare il file shape in una cartella con permessi di scrittura e lettura.

• Il nuovo layer sarà aggiunto nella TOC con il nome in rosso per segnalare all'utente che il layer è in
modalità editazione. Compariranno, inoltre, la console dei comandi di editazione nella parte inferiore
della vista geografica, il menù e gli strumenti di editazione.

• Rendere attivo il nuovo layer e selezionare lo strumento Polilinea. Cliccare sulla vista per indicare il
primo vertice della polilinea e così via per gli altri vertici consecutivi in modo da definire un edificio.
Per chiudere l'edificio è possibile utilizzare il menù contestuale scegliendo l'opzioni Chiudi polilinea
oppure digitando la lettera C nella console dei comandi di editazione.

• Il nuovo poligono sarà rappresentato con il colore di selezione. Aggiungere tanti poligoni quanti ne
occorrono per definire alcuni edifici/isolati. Per definire gli edifici adiacenti è possibile utilizzare lo
strumento Autocompleta poligono. A tal fine, nel menù contestuale Proprietà di modifica →
Snappings è possibile attivare diversi tipi di riferimento agli oggetti (punto finale, punto più vicino,
ecc.).

• Probabilmente, in fase di editazione, capiterà di dover modificare la posizione di un vertice definito in
precedenza. Per fare questo, utilizzare lo strumento Seleziona (nella barra degli strumenti di
editazione), quindi selezionare il vertice che si desidera spostare e cliccare successivamente sulla
nuova posizione per quel vertice.

• In caso di errore, è possibile utilizzare i pulsanti Annulla/Ripeti (raffiguranti delle frecce) per annullare
o ripetere l'ultima operazione o, in alternativa, cliccare sul pulsante Lista dei comandi mediante la
quale sarà possibile fare altrettanto.

• Un'altra operazione da fare consiste nell'editazione della tabella degli attributi associata al layer
edifici. Per fare ciò, prima di tutto selezionare nella vista il poligono del quale intendiamo editare
gli attributi, quindi aprire la tabella associata al layer e editare il campo dest_uso in corrispondenza
della riga selezionata, utilizzando ad esempio valori come: pubblico, residenziale, promiscuo,
commerciale, ecc. Chiudere la tabella al termine dell'editazione.

• Al termine dell'editazione, è necessario salvare le modifiche apportate al layer vettoriale dal menù
(Layer → Termina editazione o anche solo Termina editazione nel menù contestuale del layer nella
TOC). In questo modo, il nome del layer tornerà nuovamente in nero (prima era in rosso).

• Il passo successivo consiste nel rappresentare le destinazioni d'uso degli edifici mediante
un'opportuna simbologia: attraverso il menù contestuale Proprietà/Simbologia, scegliere il tipo
Categorie/Valori unici e dest_uso come campo di classificazione. Cliccare su Aggiungi tutto,
applicare le modifiche per avere un'anteprima della simbologia e, infine, accettare.
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13.2   Shapefile delle geometrie derivate

• Aggiungere il layer toponimi_foggia_4326.shp e selezionarlo nella TOC.

• Cliccare sull'opzione di menù Layer/Crea shapefile delle geometrie derivate (si tenga presente che
tale opzione diventa attiva solo in presenza di shapefile di punti e di linee)

• Il layer di origine sarà quello selezionato nella TOC, mentre invece occorre digitare il nome del nuovo
layer, come distanza_toponimi.shp che può essere salvato in
~/Desktop/gvSIG_GFOSSDay2011/risultati.

• Selezionare Linee come tipo di geometria e Da punti a linee come tipo di processo. Cliccare
quidi su Accetta. Nella finestra successiva è possibile vedere la tabella del layer di origine, cliccare
quindi sul pulsante Aggiungi tutti gli oggetti se si desidera aggiungerli tutti. In caso contrario,
selezionare gli elementi del layer di origine da cui derivare il nuovo file shape e poi cliccare sul
pulsante Aggiungi elementi selezionati. Se si vuole aggiungere o rimuovere uno o più elementi,
cliccare sui pulsanti più o meno, dopo averlo/i selezionato/i.

• Cliccando su Genera il nuovo layer sarà creato e aggiunto nella vista corrente sopra tutti gli altri
layer.

13.3   Collegamenti ipertestuali su layer vettoriali
E' possibile collegare immagini, file di testo, HTML e PDF a geometrie appartenenti ad un layer vettoriale.
Questa funzione in gvSIG è chiamata Iperlink.

• Aggiungere il layer prov2010_g.shp alla vista, selezionare le province pugliesi e realizzare uno
Zoom alla selezione. Esportare il layer come nuovo shapefile all'interno di una cartella con permessi
di lettura e scrittura, in quanto è necessario editare il layer per aggiungervi i collegamenti ipertestuali.
Selezionare quindi il layer nella TOC, cliccare poi su Layer/Esporta/SHP per salvare solo la
selezione corrente come province_puglia.shp.

• Iniziare l'editazione del nuovo layer, aprire la sua tabella degli attributi e cliccare su Tabella/Modifica
struttura della tabella. Definire tre nuovi campi: link_img, link_html e link_pdf, tutti di tipo
String e di lunghezza pari a 100. Ognuno di questi campi sarà popolato con il percorso del file che
vogliamo utilizzare per l'iperlink.

• Ad esempio, possiamo collegare l'immagine dello stemma della Provincia di Foggia. In questo caso,
la prima operazione da fare consiste nell'identificare il record della tabella dove inserire il link.

• Aprire la tabella degli attributi e usare lo strumento Filtro con la seguente espressione NOME_PRO =
'Foggia' in modo da selezionare la provincia di Foggia. La selezione avverrà sia nella vista che
nella tabella. In corrispondenza del record selezionato inserire il percorso del file
Provincia_di_Foggia-Stemma.png (senza estensione finale) nel campo link_img:
~/Desktop/workshop gvSIG/dati/Provincia_di_Foggia-Stemma.png

• Analogamente, selezionare la provincia di Barletta-Andria-Trani e nel campo link_html scrivere
l'URL del sito istituzionale di tale Provincia:
http://www.provincia.barletta-andria-trani.it/

• Infine, selezionare la provincia di Bari e nel corrispondente campo link_pdf editare il link del file
~/Desktop/workshop gvSIG/dati/orari_bus.pdf.

• Dopo aver effettuato le operazioni precedenti, chiudere la tabella e terminare l'editazione del layer.
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• Ora è il momento di impostare i collegamenti ipertestuali nelle proprietà del layer. Nella finestra
Proprietà del layer, recarsi alla scheda Iperlink e abilitarli.

• Per il primo tipo di iperlink (immagine), selezionare il campo relativo (link_img), inserire jpg come
estensione e scegliere Collegamento a file di immagine come campo di collegamento.
Quindi cliccare su Aggiungi azione e ripetere la stessa operazione con gli altri due tipi di
collegamenti ipertestuali (link_html e link_pdf). Accettare le modifiche nella finestra Proprietà
del layer.

• Alla fine, tornare alla vista e cliccare sulle province sopra citate con lo strumento Iperlink avanzato.
Si vedrà l'immagine, la pagina web e il pdf, ognuno all'interno di una finestra.

14   Mappe

14.1   Stampa veloce
È possibile stampare una vista in maniera semi-automatica con lo strumento chiamato Stampa veloce
(menù Vista → Stampa veloce). Si aprirà una finestra contenente alcune opzioni. Sarà generata
automaticamente una mappa pronta per la stampa.

• Creare una vista. Rinominarla in Puglia.

• Aprirla e aggiungervi il layer province_puglia.shp.

• Selezionare il layer nella TOC e configurarne la legenda (tasto destro del mouse sul layer: Proprietà
→ Simbologia) scegliendo il tipo Categorie/Valori unici e NOME_PRO come campo di classificazione.

• Cliccare sull'opzione di menù Vista → Stampa veloce e impostare i parametri seguenti:

• Formato: A4

• Orientamento: Orizzontale

• Titolo: Province della Puglia

• Mostra legenda: ok,

• Mostra griglia: ok,

• Immagine: predefinita.

• Quindi, cliccare su Anteprima. La nuova mappa sarà generata e, una volta soddisfatti del risultato,
sarà possibile stamparla o esportarla in formato PDF.

14.2   Composizione di una mappa
Per comporre una mappa esistono due possibilità: creare una nuova mappa oppure utilizzare un modello
di mappa creato in precedenza.

• Caricare il modello chiamato tavola_workshop.gvt (menù File → Apri tavola).

14.3   Aggiunta di una vista

• Inserire la vista Puglia all'interno della mappa (menù Mappa → Inserisci → Vista).
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• Aggiunta di una griglia nella vista. Selezionare la vista, fare clic con il tasto destro su di essa e
selezionare Proprietà. Selezionare Mostra griglia e cliccare su Configura. E' possibile impostare i
seguenti parametri: intervallo, simbologia e carattere.

• Impostazione della scala della vista. All'interno della finestra di dialogo Proprietà della vista si
possono selezionare tre tipi di scale: Automatica, Mantieni scala della vista e Scala specificata
dall'utente. E' possibile realizzare zoom e spostarsi sulla vista al fine di ottenere l'aspetto desiderato
(Zoom vicino, Zoom lontano e Spostamento nella barra degli strumenti della vista). Si noti che la
vista deve essere selezionata.

• Rotazione della vista. Selezionare la vista, cliccare su Proprietà e inserire manualmente il valore
dell'angolo di rotazione espresso in gradi oppure cliccare sulle frecce.

14.4   Aggiunta di una legenda

• Recarsi nel menù Mappa → Inserisci → Legenda. Trascinare e rilasciare il mouse sull'area dove si
desidera inserire la legenda. Occorre selezionare la vista e i layer dei quali si desidera visualizzare la
legenda.

• Per modificare gli elementi della legenda, selezionare la legenda e recarsi al menù: Mappa → Grafici
→ Semplifica legenda.

14.5   Aggiunta di altri elementi della mappa

• Scala. Per aggiungere la scala recarsi al menù Mappa → Inserisci → Scala. Quindi trascinare e
rilasciare sull'area dove si desidera posizionare la scala e impostarne i parametri. Si noti che la scala
è dinamica: se varia la scala della vista, il simbolo scala sarà aggiornato automaticamente.

• Simbolo del Nord. Per aggiungere un simbolo del Nord recarsi nel menù Mappa → Inserisci →
simbolo del Nord. Ancora una volta trascinare e rilasciare sull'area dove si desidera posizionare il
simbolo, scegliendone uno tra quelli mostrati e selezionare la vista alla quale si riferisce. Si noti che
l'orientamento del simbolo del Nord è dinamico: se ruota la vista, il simbolo del Nord sarà aggiornato
automaticamente.

• Localizzatore. Per aggiungere un localizzatore recarsi nel menù Mappa → Inserisci →
Localizzatore. Quindi trascinare e rilasciare sull'area dove si desidera inserire il localizzatore e
impostare i parametri richiesti.

• È possibile aggiungere altri elementi come testi, rettangoli, linee o immagini.

• È possibile raggruppare, separare, allineare, mettere di nuovo e portare in primo piano tutti gli
elementi (menù Mappa → Grafici → ...).

14.6   Stampa di una mappa

• Per stampare una mappa recarsi nel menù Mappa → Stampa. Sarà visualizzata la finestra di dialogo
di stampa.

• Invece di stampare una mappa, è anche possibile esportarla come file .pdf o .ps (PostScript) dal
menù File → Esporta come....
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